CERTIFIED TRAINING CURRICULUM

for the 3Play 4800

Video Notes
Training Curriculum Video Notes
for the 3Play 4800

This is the Video Notes for the 3Play 4800 Training Curriculum. It contains an outline of the instructional videos, important notes from the video content, a selected list of keyboard shortcuts, and a list of acronyms used in the curriculum.

These notes are intended as a supplement to the instructional videos, not to stand on their own. They are not a complete textbook, but rather contain the ideas from the videos that call for special emphasis. The learner is encouraged to add their own notes based on what they find the most useful content from the videos.

Table Of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Outline</td>
<td>2</td>
</tr>
<tr>
<td>Video Notes</td>
<td>4</td>
</tr>
<tr>
<td>1 Introduction</td>
<td>4</td>
</tr>
<tr>
<td>2 Physical Setup</td>
<td>6</td>
</tr>
<tr>
<td>3 The Home and Session Page</td>
<td>11</td>
</tr>
<tr>
<td>4 Interface and Control Surface Tour</td>
<td>16</td>
</tr>
<tr>
<td>5 Live Desktop and Input/Output</td>
<td>19</td>
</tr>
<tr>
<td>6 CLIP LIST, PLAY LIST, and Tags</td>
<td>25</td>
</tr>
<tr>
<td>7 Modes</td>
<td>27</td>
</tr>
<tr>
<td>8 Basic Workflow</td>
<td>28</td>
</tr>
<tr>
<td>9 Advanced Event Creation</td>
<td>31</td>
</tr>
<tr>
<td>10 Working with the CLIP LIST</td>
<td>34</td>
</tr>
<tr>
<td>11 Tagging Clips</td>
<td>36</td>
</tr>
<tr>
<td>12 Adding Media</td>
<td>40</td>
</tr>
<tr>
<td>13 Playback Speed Control</td>
<td>42</td>
</tr>
<tr>
<td>14 CLIP LIST Workflow</td>
<td>43</td>
</tr>
<tr>
<td>15 Dual Outputs</td>
<td>44</td>
</tr>
<tr>
<td>16 Working with the PLAY LIST</td>
<td>47</td>
</tr>
<tr>
<td>17 Social Media Publishing</td>
<td>50</td>
</tr>
<tr>
<td>18 Exporting Media</td>
<td>53</td>
</tr>
<tr>
<td>Appendix A: Selected Keyboard Shortcuts</td>
<td>55</td>
</tr>
<tr>
<td>Appendix B: Acronyms Used in the Training Curriculum</td>
<td>56</td>
</tr>
</tbody>
</table>

March 2014

Copyright © 2014 NewTek, Inc. LLC. Trademarks: NewTek, 3Play, 3Play 8000, 3Play 855, 3Play 850 Extreme, 3Play 850, 3Play 455, 3Play 450 Extreme, 3Play 450, 3Play 40, IsoCorder, IVGA, SpeedEDIT, 3PLAY, 3PLAY 4800, 3PLAY 820, 3PLAY 425, LiveText, Datalink, LiveSet, LiveMatte, TimeWarp, LightWave, LightWave 3D and LightWave CORE are trademarks of NEWTEK. All other brand names, product names, or trademarks belong to their respective holders.
Video Outline

The 3Play curriculum has 18 videos with a total of 95 subsections. The total running time of all videos is about 1:36:40. Each video lists its total running time with each subsection listing its start time within that video.

On the curriculum web page, there are four additional workflow example videos showing the techniques developed in the curriculum videos.

1 Introduction 2:00
   a) Introduction 0:05

2 Physical Setup 9:33
   a) Media Drives 0:05
   b) eSATA Connection 2:00
   c) Video Input Connections 2:10
   d) Video Output Connections 4:15
   e) Audio Connections 6:05
   f) Monitor Connections 7:05
   g) Network Connection 7:30
   h) Other Connections 8:05
   i) Front of Machine 8:30
   j) Genlocking 9:20

3 The Home and Session Page 11:07
   a) Help Icon 0:15
   b) Registering the 3Play 4800 1:00
   c) Updating the 3Play 2:40
   d) Backup and Restore System 3:10
   e) Other Options 4:10
   f) Creating a New Session 4:45
   g) Import Media 7:10
   h) Social Media Sharing 9:35

4 Interface and Control Surface Tour 3:35
   a) Interface Overview 0:05
   b) Control Surface Overview 0:50

5 Live Desktop and Input/Output 14:39
   a) The Publish Queue 0:05
   b) The Options Menu 1:25
   c) Help Menu 3:25
   d) Message Area 3:35
   e) Disk Storage Area 4:00
   f) The Grab Button 4:25
   g) Production Clocks 5:05
   h) Multiviewer Area 6:15
   i) Output Configuration 7:45
   j) Genlock 11:55
   k) Failsafe 12:40
   l) Recording 13:20

6 CLIP LIST, PLAY LIST, and Tags 3:28
   a) Organizing the CLIP LIST 1:05
   b) The PLAY LIST 1:40
   c) The TAGS Area 2:40

7 Modes 1:49
   a) Modes 0:05

8 Basic Workflow 6:02
   a) The Workflow 0:05
   b) Marking Events 1:10
   c) Recording 1:45
   d) More Marking Events 2:30
   e) Cueing Events 3:40
   f) Playing Events 5:10
   g) Out Point Padding 5:30
Advanced Event Creation 5:33
a) One Button Marking 0:10
b) Out Point Padding 1:45
c) Mark In with No Out 3:10
d) Delayed Playback Mode 4:00
e) Bookmarking 4:50

Working with the CLIP LIST 2:29
a) Choosing Playback Angle 0:05
b) Clip Angle Previews 0:45
c) Unavailable Assets 1:45
d) Frame by Frame Viewing 2:00

Tagging Clips 9:17
a) TAGS Area Overview 0:30
b) Editing Tags and Tabs 1:20
c) Applying Tags to Events 3:25
d) Auto Advance 5:50
e) Searching for Tag Information 6:50
f) The Event ID 7:45
g) Using GO TO 8:15

Adding Media 1:36
a) The Add Media Button 0:05
b) Media Browser 0:40
c) Add Media Location 0:50
d) Other Important Notes 1:05

Playback Speed Control 1:35
a) Playback Controls 0:05
b) The +/- Button 0:55

CLIP LIST Workflow 1:00
a) Playout from One Output 0:15
b) Jumping to Different Angles 0:40

dual Outputs 7:53
a) Dual Outputs 0:05
b) Linking Both Outputs Together 0:20
c) Preview to Program Workflow 1:45
d) AutoPlay 2:20
e) Using the TAKE Button 2:40
f) Setting up a Transition 3:25
g) Using a Transition 5:25
h) Speed Control Using 2 Outputs 6:35

Working with the PLAY LIST 6:08
a) PLAY LIST Tabs 0:05
b) Adding Clips to the PLAY LIST 0:30
c) Adjusting Clip in the PLAY LIST 1:10
d) PLAY LIST Transitions 1:25
e) The Ends At Time 2:15
f) Adding Music to the PLAY LIST 3:15
g) Playing the PLAY LIST 3:50
h) Adding Media to a PLAY LIST 4:35
i) External Editors 5:00
j) Exporting PLAY LISTs 5:30

Social Media Publishing 5:48
a) Publishing 0:05
b) Publish Destinations 1:00
c) Auto Upload 1:45
d) Adding Media to the Queue 2:10
e) Adding Stills 4:10
f) Publishing Locally 5:20

Exporting Media 3:09
a) Exiting the Session 0:05
b) The Export Media Panel 0:45
c) Edit Decision List (EDL) 2:50
Video Notes

1: Introduction

a) Introduction (0:05)

The 3Play 4800 is an 8 input, 2 independent output instant replay and slow motion server. It can bring in and record up to 8 live video sources with audio in a variety of formats and resolutions and has 2 independent outputs. It creates events which can be replayed from multiple camera angles and can jump between the angles during playback. You can play out of one output while setting up the next angle in the other or use them together to simultaneously output two camera angles of the same play.

The 3Play 4800 can transition from one angle to another using a preview/program style workflow. Transitions can be standard wipes and fades or you can use the Animation Store transitions with full color overlays and sound effects. Even 3D warping is possible. You can create your own transitions using logos and artwork.

The playback speed can be dynamically controlled from the Control Surface. The Tagging system allowing you to attach detailed information to a clip for easy queuing and playback with a few keystrokes on the Control Surface. The Playlist creates melts or highlight reels which can have transitions between the replays and play over a music track.
Video clips and stills can be uploaded to social media sites from the replay system during the event while it is still recording. It also allows you to export clips or melts in a variety of formats for use outside the system.

Notes: ____________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________
2: Physical Setup

On the inputs, you can mix HD and SD video in both digital and analog formats. Be careful to correctly attach the input and output cables as this is likely to be difficult to change once the live production has started.

a) Media Drives (0:05)
The 3Play 4800 comes with four 2TB hard drives to populate the removable hard drive bays. The hard drives are labeled D, E, F and G and correspond to each drive bay in that order from top to bottom. Each drive can store about 50 hours of 1080i video. These drives must formatted using the NTFS file system.

Do not transport the 3Play with the drives installed. This may damage the unit.

If the 3Play 4800 is to be mounted in a rack style system, use the optional rack mount rails. Securing the unit in a rack using only the ears on the front panel with screws can damage the unit.

b) eSATA Connection (2:00)
An eSATA port on the back of the 3Play allows an external drive to be connected for expanded storage.

c) Video Input Connections (2:10)
The 3Play 4800 features eight video inputs and each can be different resolutions or formats.
To connect SD SDI or HD SDI, attach the cable to the SDI row for the desired input.
To connect composite video, use the Y row for the desired input. To attach Y/C video, use Pb for the Y cable and Pr for the C cable for the desired input. To attach YUV component video, use the Y, Pb and Pr rows for the desired input. The Red cable attaches to the connection labeled Pr; the Green cable goes on the connection labeled Y; and the Blue cable goes on the connection labeled Pb.

High definition video can only be brought in through a component or an SDI connection.

When connecting video sources to the 3Play system, DA or split each camera feed and send one to the 3Play and one to the switcher. Avoid using T connectors or looping video back out of the switcher into the 3Play. This may cause undesirable delays. Give the same attention to cable length as you do with the switcher. For example, if a source comes directly to 3Play, it must follow cable length specs and consideration.

You can mix and match any combination of HD and SD in both digital and analog formats on inputs for a live production. The 3Play will successfully scale up an SD composite signal for an HD production, but the video may look a bit soft.

An SDI connection carries both audio and video on a single cable.

d) Video Output Connections

There are three output rows (actually columns) on the backplate of the 3Play labeled 1, 2, and 3. SDI outputs are the second row of BNC connectors. Analog outputs are just below and connect in the same manner the inputs connect.

There are two independent outputs labeled 1 and 2 on the backplate of the system. By default Output 1 is Output A and Output 2 is Output B but they can be renamed in the interface. Each output also has SDI and analog active at the same time.

The third output, Output 3, is Aux out. This is a switched output showing what is happening on the currently selected output on the Control Surface. If A is selected, then it outputs Channel A and if B is selected it outputs Channel B. You can also think of Output A as preview and Output B as program when using the transitions between outputs. When using transitions between camera angles in the clip list, Output B is the main output. Output resolution matches the session resolution you set up for the live production. All outputs are the same resolution. All outputs will deliver digital and analog at the same time so it is really six video outputs arranged in three rows.

There is an HDMI connector labeled 4 on the back of the system. This is also a switched Audio/Video output like output row 3, and it displays whatever is currently selected on the Control Surface and use the audio from that output as the HDMI audio. This gives seven active video outputs.
There are two display connectors labeled 5 and 6 and they are an HDMI and a VGA connector respectively. These connectors are not used in the operation of a 3Play 4800; do not use them.

e) Audio Connections

Eight analog audio inputs are located along the top of the back plate. Each is a pair of stereo connections corresponding to the video inputs. They can also be independent stereo inputs. External linear time code is attached to audio Input 7.

The AES/EBU connectors take four channels of digital audio.

Audio can also be brought in via the SDI video signal. The 3Play accepts the first four channels of audio on each SDI connection.

The connectors numbered 1a, 1b, and so-on provide Channel A output audio, while 2a etc., are assigned to Channel B. These two output sections are configured and controlled separately in the 3Play Desktop. AUX (Row 3) carries the same audio as either Channel A or Channel B, depending on the 3Play’s current Channel Delegate selection.

The two BNC connectors identified as 1ab and 1cd in the AES section (below the analog audio outputs) section carry AES/EBU (AES3) audio.

f) Monitor Connections

The 3Play requires at least one monitor which is attached to the DVI connection on the back of the machine to use as the main user interface. The monitor must be able to display 1600x1050 or greater.

Setting the main interface resolution to 1920x1080 allows for more screen area to accommodate the system controls.

A second monitor can be attached to use as a Multiviewer. It is recommended, but not necessary, to run the 3Play. The layout of the Multiviewer can be adjusted from the main interface.

g) Network Connection

There is a gigabit Ethernet connector on the back of the machine allowing you to connect to a network and the internet. This is useful when using the Publishing features for uploading video to social media sites. It can also be used to send the output of the 3Play system to any 3Play’s network inputs across the network. This is full frame rate video and sound across the network. This means when using a 3Play as the switcher you don’t have to give up any live inputs to get two channels of instant replay.
h) Other Connections

(8:05)

Make sure there is room for the Control Surface, keyboard, and mouse in your production area.

Connect the USB cable to the Control Surface, then to the 3Play using one of the available USB ports on the back of the system.

Manage cables during a production to ensure they are out of the way and do not run across areas where people could walk and trip on them.

Plug power cables into the back of the 3Play, then to a reliable power source. Make sure the power supply switches are turned on. NewTek recommends you connect the 3Play to two separate power supplies. If you are going to use a power conditioner or uninterrupted power supply, make sure it is a pure sine wave model. This will be denoted on the box of the uninterrupted power supply in its specs.

A beeping sound when powering up the system indicates one of the two power supplies is not functioning, is not on, or is not getting power. The alarm can be silenced by depressing the button next to the power cable input on the back of the 3Play. The system can run on one supply, but it is always best to use both.

i) Front of Machine

(8:30)

The removable drive bay for the media drives are on the front of the machine. The 3Play 4800 is smart enough to know what drives are used for what in a session, so even if the drive letters change by pulling drives in and out, the session will still load properly.

The power switch is found on the front of the machine. If you try to use this and get no response, make sure the power supply switches on each power supply are also on.

If you power on the system and hear a beeping alarm, it can mean one of the power supplies is not functioning properly. Make sure they are on and plugged in. If you still get an alarm it can be silenced using the small button next to the power supplies. You can run on one power supply, but it is best to have both in working order.

j) Genlocking

(9:20)

The Genlock feature allows the video output to be locked to reference video signal supplied to the Genlock connector at the back of the 3Play. The 3Play supports both Bi-Level and Tri-Level genlock signals.

Genlocking is not required to use the 3Play, but NewTek recommends it to keep latency from drifting.
When you first start the 3Play system you are brought to the *Home* page. Here you have a variety of options available on the menu ring.

a) *Help Icon* (0:15)

The *Help* icon gives access to the user guides for all of the products available in the system including 3Play and Animation Store Creator. These are searchable PDF files. If you wish to print them, please visit the NewTek website at newtek.com, go to the *Support* pull down, and select *Updates and Downloads*. All the user guides and can be read or printed from here. It is better to print from an external computer to avoid having to load printer drivers onto the 3Play.

b) Registering the 3Play 4800 (1:00)

The first time the 3Play is operated it should be registered. Registering your system is important as failure to do so will result in a water mark on the outputs. To remove the water mark, register the unit. The two items of information needed to register the 3Play are the serial number and the product ID.

For ease of registration, connect the 3Play to the internet. If the system does not have an internet connection, use another computer that has internet access and go to [http://register.newtek.com/Splash.aspx](http://register.newtek.com/Splash.aspx) and register, but you will need...
the serial number and the product ID found when you press the Registration button.

If no internet connection is available, call support services at 1-800-862-7837 in the US or +1 210-370-8452 outside of the US and register over the phone. The product ID and serial number are necessary to register and support services will give you the unlock code. Online registration can happen 24/7, but support services is only open Monday through Friday 8:30 a.m. to 7 p.m. Central time and Saturday and Sunday from 10 a.m. until 2 p.m. Central time.

When you register the 3Play, you’ll have a password protected NewTek account which you should visit periodically to get 3Play updates and other information. It’s a good idea to write down the Window product key, the 3Play serial number, and 3Play registration code. Keep these numbers in a safe place in case you need them in the future.

A warning may appear if other software besides the 3Play is installed on the system. If Restore is pressed at this warning, the 3Play reverts to the factory defaults and removes any other software.

c) Updating the 3Play

Once the 3Play is registered, notifications are sent via email when updates are available. You should check for updates frequently and always immediately after doing a system restore. Do not do manual updates to drivers or Windows™ as this may cause undesirable results. Any necessary updates will be added within a NewTek update.

Recording and deleting files can cause the drives to become fragmented, resulting in slower multi-stream playback. A utility to de fragment the hard drives is provided if needed.

d) Backup and Restore System

If problems occur with the 3Play, NewTek technical support may advise you to restore it. You should only do a system restore on the advice of NewTek technical support. When you restore the 3Play, the system drive is completely overwritten and restored to the factory defaults; this erases any system updates, as well as any add-on software installed. These will need to be reinstalled and the system updated after the restore is complete. None of the content on the media drives is affected by doing a system restore. Only install software made for the 3Play.

The backup of the system drive is unique to each 3Play. If more than one 3Play is owned, create a separate backup drive for each unit.

Refer to the User Guide, contact your reseller or NewTek Support Services for advice on using this feature.
Remember to set the interface monitors to run at the 3Play’s maximum resolution of 1920x1080 if possible, but you need a resolution of at least 1600x1050 to run the system.

e) Other Options

The **Shutdown** menu has three options:

- **Restart** to restart the entire system, including the operating system.
- **Shutdown** to shut down the entire system and power off.
- **Exit to Windows** to gain access to Windows™ features.

The **Open** icon also has three options:

- Access to any existing session on the system.
- Drive options.
- Eject drives.

f) Creating a New Session

Each production has its own session file. There are numerous session parameters to set up before a production, and the session file contains all of this information. Managing sessions carefully saves a lot of time and headaches.

To start a new session, click on the **New** icon on the ring. It's always a good idea to use meaningful file names for all your media, and the sessions you create as well. If you don’t type a name for a new session, the current date becomes the name.

To rename or delete an already existing session, right-click on the session name and choose that option from the context menu. Deleting a session also deletes any media recorded during that session.

Start a new session when doing a unique event; re-use an existing session for shows that have the same format, cameras, and media. You can choose to start a default session or use another session as a template. This would load all the camera connection types minus the content. This is great to start up a new show but maintain all your camera settings.

For instance, you can start a session called Morning Show and set up all the cameras and recording preferences. Then exit morning show and go back to **New**. Then use Morning Show as the template for the Evening Show and all the cameras and preferences are set up and you just need to add content.

A redundant session is a four camera session with two backup drives. This means it is recording four live inputs but creating a backup of the recording at the same time. Anything recorded to one drive is recorded to two for the ultimate backup. Or, you can choose to work with the maximum number of cameras which is eight.
You can configure what streams get recorded to what drives. Remember, no more than two streams per drive. Recording should only be done using an internal media drive or an external eSATA drive for the best speed. The configuration of what streams go to what drives can only be done here, this cannot be changed once you are in a live session.

Choose which drive to save the session to. Do not use a USB drive as a session drive. Only drives in the removable drive bay or media attached through the external eSATA port should be used.

The 3Play must have at least one media drive as the session drive during live operation. This drive is not removable during the live operation. If no media drives are present, a new session cannot be started.

Set the Video Standard. When the Video Standard is set, for example NTSC, all inputs and outputs must match this standard.

If setting up a session intended for distribution by a traditional media broadcast, create an interlaced session. If the event is primarily intended for distribution over the Internet, create a progressive session.

The Open icon allows access to all session that have been created. Left click on a session to open it or right click on a session to rename it.

The 3Play can be restarted from the Restart 3Play icon. This reboots the machine and returns to the Home page. Shutdown 3Play powers down and turns off the machine.

g) Import Media

The Manage icon is where you manage all the media for a live production. Proper media management is important because it ensures you have compatible media stored for easy access during a live production.

The 3Play Manage Media page is where you manage the four playable types of media files: video clips, still images, title graphics, and audio files. The Import Media function is generally the best way to import media.

If you import media from a USB drive, check it for viruses on an external computer before connecting it to the 3Play.

To import clips for use during a live show, click on the Import Media button. Click on the Add button. From here navigate to any drive attached to the 3Play. Navigate to the media to be imported, select it, and press Open.

The 3Play can read many types of media formats and resolutions, but some clips may need to be transcoded before playback in the 3Play.

When importing video clips, three things may happen:
1. The clip adds to the list, the *Transcode* button is off and ghosted. This means the clip will play with no conversions.

2. The clip loads and the *Transcode* button is on, but ghosted. This means the 3Play knows the clip needs to be transcoded on the way in and will do so.

3. The clip loads and the *Transcode* button is off but not ghosted. This means the 3Play thinks it can play the clip with no conversion. (You can import the clip with no conversion and test it in playback. If you have an issue, re-import the clip and transcode it for smooth playback).

When all your media is loaded into the import requester, press the *Import* button. Once everything is imported, the import requester is empty.

h) Social Media Sharing

At the top of the *Session* page at the upper right hand corner are the icons for social media sharing. Clicking on any part of the icon or the gear launches the account configuration panel for social media sharing. This is where you enter the information to log onto social media sites or FTP and local storage options. Log into Facebook, Twitter or YouTube using your username and password. Here, you set a local or network drive as a destination for any shared media allowing editors or social media technicians to edit the content during the event. You can also log into a FTP site and upload shared media there. These log-ins cannot be managed from within the Live desktop.

The log-in tabs for shared media provide an option for applying a watermark which can be any image with alpha channel. This watermark then appears on any shared media where this feature is selected. When copying files to FTP or local drives, you have the option to *Prepare for Web* which will take the 100Mbs mpeg file wrapped as a QuickTime and converts it to a web format which is much smaller and easier to transport.

Notes: ________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________
a) Interface Overview

Along the top of the 3Play 4800 interface is a set of controls called the Dashboard or Title Bar. It includes the *File*, *Options*, and *Help* menus, *Message Area*, and *Disk Storage Area*. It also contains the *Grab* button, the *Record* button and the production clocks.

The *File* menu allows removable drives to be ejected, access to interface options, and to get to the online help. Exiting the 3Play Desktop from this menu returns to the *Session* page.

The *Help* menu shows QR codes that can be scanned with any smart device with a barcode scanner to load up user guides to that smart device.

The *Message Area* is where important message appear during a live production. Clicking on the green box to the left of the message removes it from the window.

The *Disk Storage Area* shows how much disk space is available for recording and how much switcher memory is available for transitions.

Just below the Dashboard is the Multiviewer which shows all of the inputs and outputs as they happen live. The four or eight smaller monitors on the left are the inputs; the two larger monitors on the right are the A and B outputs.
Just below the Multiviewer is the **CLIP LIST** showing all marked events and their camera angles. Then you have the **PLAY LIST** for creating melt or meld reels with transitions and music. And under that you have the **TAGS list** showing all the data tags available to be attached to any clip. A secondary Multiviewer is available which is also configurable for a number of layouts and options.

Throughout the 3Play interface, clicking a gear icon brings up a configuration panel for a control. These gears icons are used to configure whatever they are associated with. A gear next to an input monitor will bring up the configuration panel for that input. A gear attached to an output monitor brings up the output configuration panel.

Holding down the *Shift* key on the alpha-numeric keyboard and double-clicking on an adjustable parameter returns that parameter to its default value.

To change most button labels, right-click on the button, then choose *Rename* from the context menu.

b) Control Surface Overview

At the top-left of the Control Surface is the output selector allowing you to choose which output is currently being controlled. The outputs can be linked together for synchronized use. Next, are the transition controls for executing a *TAKE* or *AUTO* between the two outputs. When doing this, Output B will be “program out” showing the transition from B to A. Think of A as preview and B as program when working in this mode. Next, is the mode selector for switching between LIVE, CLIP LIST or PLAY LIST modes. Then there are some utility keys such as *CUT*, *COPY* and *PASTE*.

Notice some keys have two commands with a separator line. When using these keys with the *SHIFT* key you get the function on top of the line. Without the *SHIFT* key you get the function below the line. There are also action keys, including *GRAB* for grabbing images, **PUBLISH** for sending content to the social media queue, and **Add To Playlist** for sending clips to be edited in the **PLAY LIST**.

Below that is the number pad are and the **TAG**, **GO TO**, **SEARCH**, **ESC**, and **ENTER** buttons for use in tagging. Below those are the navigation buttons to move through the interface during operation. To the left of the navigation area are the transport controls for controlling video playback and cueing with the jog wheel.

Next is the **T-bar** for controlling the speed of playback. This is a zero to 100% range unless the +/- button is pressed. Then, the **T-bar** is at 0% in the center, and it can roll the clips forward or backward up to 200% speed.

Under the **T-bar** is the **SHIFT** key which is the qualifier key used during operation. Next are the **ANGLE**, **BOOK MARK**, and marking control buttons (**IN** and **OUT**) for creating events.
At the very top-right of the Control Surface is the *RECORD* button to start the recording process manually. To stop recording from the Control Surface, you must use the *SHIFT* qualifier along with the *RECORD* button.

Notes: 

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________
a) The **Publish Queue**

The *File* menu gives you access to the **Publish Queue**.

When media is sent to the *Publish Queue* it is viewable in the *Publish Queue* panel. Once in the queue, the operator can choose to upload and comment on it. Media can also be duplicated and sent to multiple destinations.

*Publish Destinations* controls where media is uploaded to as a default, and it can be set to *Auto Upload* from here once it is added to the *Publish Queue*.

*Share Media Drives On Network* allows users external to the 3Play system to add content to media drives across the network during a session. One caveat is that if the drive you are copying files to is already recording two streams and playing media back, it may cause performance issues during the copy. Only copy clips to a media drive across the network if it is not currently recording and playing back multiple clips.
b) The *Options Menu* (1:25)

The *One Button Marking* option defines how many seconds to jump back from a selected Out Point to create an In Point. If you set it to 4 seconds and press the *OUT* button, it creates an event with the Out Point set as marked and an In Point 4 seconds prior to the Out Point. This is perfect for sports that do not have a clearly defined start and stop to the action, like basketball or soccer. Jump back time can be set between 3 and 15 seconds.

*Still Image Duration* sets the default duration for a still added to a *CLIP LIST* via the *Add Media* button. Options include: *1 frame, 1 second, 5 seconds* and *10 seconds*.

The *Out Point Padding* option determines how far past the selected Out Point a clip will continue to play. When set to 5 seconds, it will continue to play for 5 seconds beyond the Out Point. Set this to *Infinite* so the replay clips never stop until you manually stop them.

During a replay it can be useful to see all the camera angles of an event as it plays back. *Show CLIP LIST Angle Previews* will put monitors for each angle of a clip being played back onto the main user interface.

When using *A/V Passthrough*, Camera 8 will become the active camera that passes through the 3Play in the event of a catastrophic software failure. When in the 4-camera redundant mode, you don’t have access to the controls for Input 8 so making adjustments on that input becomes an issue. When *AV Passthrough* is on, you can use the *Failsafe Camera Configuration* option to adjust Input 8 when in 4-camera mode.

c) *Help Menu* (3:25)

The *Help* menu shows QR codes that can be scanned with any smart device with a barcode scanner to load up user guides to that smart device.

d) Message Area (3:35)

This area shows the session name and resolution. This is also where messages are displayed by the 3Play. An example of a message is when you press *Alt + b* on the keyboard it will display the build number. This can be handy if you need to call for support. To remove the message, click on the green box.

e) Disk Storage Area (4:00)

The disk storage area shows how much time is left on the drive with the least amount of recording space. This tells how long you can record all configured channels at the same time. If a drive in a bay is not configured to be used in the recording, it will not be taken into account in this number.
f) The *Grab* Button (4:25)

The *Grab* function grabs an image from the main outputs and all inputs at the same time. To configure the *Grab* function, click the gear. The function can be set up to de-interlace grabbed images. This removes the motion in stills grabbed from interlaced video streams. This is not needed when working in a progressive session. All stills are grabbed as JPEG images.

g) Production Clocks (5:05)

To configure the production clocks, click on the gear. This is the time stamped onto the recording. If no external time code is used, the time of day is used. Make sure to set the Windows™ clock to be accurate so the time code makes sense.

External LTC time code can be brought into audio Input 7. The *Video Connection Type* pull-down is disabled for Input 7 when it is used for time code. When external time code is used, the time code display turns light blue as a visual cue.

You can also set up a second production count-down clock. When configured with the start and stop time of the production, the second time display shows up next to the first one. If the production has not started yet, this is a count-down to the start of the production. If the production has already begun, it is a count-down to the end of the production.

h) Multiview Area (6:15)

The Multiview area shows all the incoming video signals. When you mouse over an input monitor, a gear appears. Clicking on the gear opens the *Input Configuration Panel* for that input. Use the pull down to choose the format and resolution of the video coming in that input. Each input can have a different format and resolution.

You can name the input to be something more intuitive for the event you are recording.

Each input has a processing amplifier or Proc Amp. Video levels such as *Brightness*, *Contrast*, *Hue* and *Saturation* can be adjusted with the Proc Amps. The effects of these adjustments can be viewed on a waveform monitor and vectorscope. (A waveform monitor shows the luminance information of the video frame; a vectorscope shows the color information.)

It's always better to adjust color or brightness at the source of the input, such as the camera, rather than trying to fix problems with the proc amps. Always white balance the camera and only use these internal controls as slight tweaks, not main controls. Most professional cameras are able to output color bars for the purpose of calibrating the video signal.

You have the ability to configure the type of audio used for this input, including analog, digital AES/EBU or embedded SDI audio from any input. This means the
audio from Input 1 can go to all inputs. There is also a gain control for adjusting volume of an analog audio source.

i) Output Configuration

The 3Play 4800 features two independent outputs that can be configured separately.

At the bottom of each output monitor, a heads up display, or HUD, shows the current state of that output. The current mode also affects what is displayed on the HUD. In CLIP LIST mode, it shows the output’s name, a countdown clock of the time remaining for that clip, the time code of the clip itself, the Event ID and camera angle, the name of the clip, and playback speed percentage.

The HUD also highlights in a color when the output is selected in a specific mode: blue when it is in CLIP LIST mode, yellow when it is in PLAY LIST mode, and green when it is LIVE mode. These colors are also shown on the T-bar of the Control Surface as a visual cue to the state of the system.

The HUD display also shows which output is currently selected on the Control Surface by a white outline around the HUD when both outputs are linked using the LINK button.

Mousing over either output makes a gear appear. Click on the gear on Output A to open the Output Configuration panel. You will see several tabs along the top of the panel. The first two are labeled “Output A” and “Output B”. The outputs can also be renamed in the panel. Often, outputs are named to match the corresponding inputs on a switcher during a live production.

The output resolution for all three outputs always matches the session resolution. The Analog Output Type displays component in a high definition session as this is the only high definition capable format for analog. If the session is set to standard definition, this popup is active and can be selected between Component, which uses all three connectors, or Composite and Y/C which use one and two connectors respectively.

The analog and SDI outputs are both active on each output row simultaneously. It is really six video outputs in three rows. The Audio Volume control allows you to adjust the raw audio level coming from just that output. Remember, audio and video connectors on the back panel for A are labeled 1, and B are labeled 2. Output C, labeled 3, is the Auxiliary output and is a switched output which means whatever output is currently selected on the Control Surface.

Also from this panel you have options for the Auxiliary output (Output 3) and the Multiview layout. This is the DVI connector labeled Multiview on the back panel. Your options include

1. Outputs/inputs and clocks
2. Outputs and clocks
3. Inputs, outputs, and CLIP LIST playbacks
4. Output A
5. Output B

You can also adjust the resolution for the second monitor allowing you to use almost any monitor as a multiviewer. By making the Multiviewer into Output A or B, you create a DVI version of that output. This should only be used by the operator and should not be used as an output visible to the viewers since it is a preview and of lower quality than an actual output.

j) Genlock

The Genlock feature in the 3Play syncs or locks the video output to a black burst or house sync signal. The 3Play accepts either Bi-level (Standard Def) or Tri-level (High Def) genlock. The positioner tools and the phase tool are available to adjust the genlock signal for perfect sync.

The Center Frequency control is used when genlock is not being used. In this case, input color bars, pass them through to an output, then to a vector scope. When the vector scope image is completely stable, center frequency is correct.

k) Failsafe

Failsafe is a feature to ensure video is always passing through the system, if at all possible. There is a button to enable or disable this feature. Some broadcast systems have their own fail safe system that detects when video is no longer being supplied. When it detects this, their failsafe system kicks in. If this feature is on in the 3Play, then video is always passing through and the external failsafe system will never kick in. Only turn this feature on if you don’t have an external failsafe system in place. By default, A/V Pass Through is off.

l) Recording

The 3Play can record up to eight channels of HD video with audio simultaneously. Each channel can be configured. There is a Record button on the interface and on the Control Surface which starts and stops recording. All files are recorded as Quicktime™ files. The 3Play must be recording to function as a replay system.

Once you start recording, every frame on every input will be recorded regardless of the set In and Out Points. You can even go back after an event has passed or after the game is completely over and create new events. As long as you are recording before the game starts and don’t stop until the game is over, you have all video from every angle available.

If the 3Play is not recording, as soon as you press the IN button the record process is started and you can see this on the interface and on the Control Surface by an
illuminated \textit{RECORD} button. To stop recording, click on the \textit{RECORD} button in the interface. On the Control Surface you must press \textit{SHIFT + RECORD} to stop recording.

Notes: ________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________
Captured events are displayed in the CLIP LIST when created. Each event has an angle or clip for each recorded camera. For instance, if the 3Play is recording four cameras, then each event will have four camera angles. Inputs can be named from within their configuration panel. If an input has been named, that name also appears for its camera angle.

Each created event has an Event ID, an In Point, an Out Point, a Duration, and the camera angles for the event. Each angle of an event in the CLIP LIST can also have information attached to it. Information is entered in the FastClip dataview port and displayed there and on the clip itself.

a) Organizing the CLIP LIST

The CLIP LIST can be organized by using the tabs. There are 10 tabs for the CLIP LIST. Tabs can be renamed by right-clicking on them and choosing Rename.

To select a new tab, click under the Multiviewer, or select CLIP LIST mode on the Control Surface, then use the TAB buttons to select the desired tab.
b) The **PLAY LIST**

(1:40)

Below that is the **PLAY LIST** where you can add clips to be used in melt reels with transitions and music. This area is organized using ten tabs by default, but you can use the + button to add as many as you want.

To select a new tab, click above the **PLAY LIST**, select **PLAY LIST** mode on the Control Surface, then use the buttons to select the desired tab.

Tabs can also be renamed by right clicking on them and choosing *Rename*. Once you add several tabs, small arrows appear on either side of the tabs in the **PLAY LIST** to navigate through them.

Tabs can also be deleted by right-clicking on a tab and selecting *Delete* if that option is available.

c) The **TAGS** Area

(2:40)

Below that is the **TAGS** area. This area can be hidden or revealed using the mouse and the button labeled **TAG**, or by pressing **SHIFT + TAG** on the Control Surface. It can also be scaled using the mouse. The center area of the bar hides and reveals the tags, but the outer areas allow scaling the **TAGS** area.

The **TAGS** area defines text tags that are added to any event with a keystroke. For instance, with just three key strokes, a clip can be tagged with a player number, a team name, and an action that occurred. This is all then data associated with the clip which can be searched or indexed.

Notes:  ........................................................................................................
........................................................................................................
........................................................................................................
........................................................................................................
........................................................................................................
........................................................................................................
7: Modes

a) Modes

The 3Play works in one of three modes: LIVE, CLIP LIST, or PLAY LIST.

Pressing the LIVE button shows the live sources currently selected for the output. The camera seen is adjusted by changing the angle. To do this, press the ANGLE button on the Control Surface, then select a number on the number pad to select the corresponding angle.

Pressing the CLIP LIST button activates CLIP LIST mode and displays and sets the 3Play up to recall a replay of an event from any angle.

Pressing the PLAY LIST button activates PLAY LIST mode, allowing for the creation of melt reels with transitions and music.

You can also click in the CLIP LIST or PLAY LIST to change that to the active mode. Be careful when clicking on the interface during a live event, make sure you know what mode you are in since this can change what is happening on output. You can always determine this by seeing which button is lit on the Control Surface or checking which area of the interface is highlighted.

There is one more mode, called the Tag mode, which adds pre-defined tags to clips with minimal keystrokes on the Control Surface. The tags matrix on any tab in this area can be edited. Then, when in Tag mode, entering the cell number adds the text associated with that cell to the clip. You can have multiple tabs with different categories of information that auto advance each time a tag is applied.

Notes: ____________________________________________

_____________________________________________________

_____________________________________________________

_____________________________________________________
8: Basic Workflow

a) The Workflow (0:05)

Producing instant replay for live production is an art. The basics of instant replay are about quickly and easily being able to do three things: mark events, cue events, and play events. We refer to this as Mark it, Queue it, Play it.

Before starting each replay session, you should think about the type of live action being captured and replayed. Evaluate the event and place it in a category:

A. Sports with definable 'start' and 'stop' replay opportunities, like American football.
B. 'Continuous action' sports where the magic moment in time reveals itself when it happens and is not predictable, like soccer and basketball.
C. Sports that share aspects of A and B, like baseball.
D. Finish line sports like track and racing.

The type of action you are trying to capture determines the preferred workflow.

b) Marking Events (1:10)

One way to create an event is to mark an In and Out Point. This is a traditional workflow for creating clips for playback. It works well for sports that have a predictable start and stop point for the action, such as American Football. The marked In and Out Points are pointers to that point in time on the master recording. Everything from all angles is always recorded when in recording mode.

c) Recording (1:45)

Start recording before the game starts. To do this, click the RECORD button on the interface or press the RECORD button on the Control Surface. Recording starts automatically when the IN button is pressed, but it is best to start recording before the event begins to catch any pre-game activities and to be sure you are recording as the event starts, not just when you mark the first In Point.
Once recording, the 3Play records everything from all inputs. Even if you don’t mark an In or Out Point, the content is recorded and you can go back and retrieve it and make new events at any time. Every camera for the whole game is recorded.

d) More Marking Events

First, press the A or B button to select a current output. Then, press the LIVE button to enter the LIVE mode. Look at the live feeds and pick an angle to work with to create the event.

All the live cameras are seen on the Multiviewer or on the output by using the ANGLE button and the number pad on the Control Surface to select a desired angle. The live feeds are also seen on the secondary Multiviewer which can be configured in a number of layouts.

Press the IN button at the start of the action. If you press it too soon, you can reset the In Point at anytime by pressing the IN button again.

Notice this creates an event entry in the CLIP LIST. The event consists of all camera angles that were being recorded as inputs. Notice also that the IN button is blue and remains blue until this event is completed.

At the end of the action, press the OUT button. This completes the event with an Out Point and duration.

e) Cueing Events

To cue a clip for playback, press the CLIP LIST button and make sure the T-bar on the Control Surface is at 0% by pulling it all the way towards you. The camera input you were viewing during the event creation is now the selected camera angle for playback.

To select a different camera angle, hold down the ANGLE button and use the number pad on the Control Surface to select an angle or single-click on a clip. You can also use the arrow keys on the Control Surface to go to the next or previous angles.

Once a camera angle is selected, you can use the jog wheel to change the In Point. Changing an In Point in the CLIP LIST adjusts the In Point of every camera angle in that event. Use the wheel to jog the clip. You can use the Fast Jog button to increase the speed at which the wheel transports the video stream, making it move 8 times faster. If you spin the wheel to the left, eventually the marked In Point is reached and the clip stops.

It is possible to move back beyond the In Point. Hold down the SHIFT key and continue turning the wheel left. When the desired In Point is reached, continue to hold the SHIFT button, then press the IN button. This sets the new In Point and the clip is cued.
f) **Play Events**  
(5:10)

With the camera angle selected, use the *T-bar* to initiate playback and to dynamically change the playback speed. If the *T-bar* is already up, move it back down to the 0% position to cause it to take control of playback speed.

g) **Out Point Padding**  
(5:30)

There is an option to have the clip play beyond the Out Point for a specified period of time, or forever. This is recommended since you never know when the director will want you to hang on a shot. To do this, go to the *Options* menu and select *Out Point Padding*. Setting this to *Infinite* causes the clip to play without stopping until you stop it. You can also set it to play for a specific amount of time after the Out Point or to stop directly on the Out Point by disabling *Out Point Padding*.
There are some advanced ways to create events.

a) One Button Marking

One way to create an event is to use “one button marking”. This is very useful for sports that have no obvious start to the action like soccer, hockey, or basketball. This method shows action previous to the Out Point when no In Point was created.

To use one button marking, make sure you are recording and in LIVE mode. The idea is to mark an Out Point and jump back in time to automatically set an In Point.

You can select how far back in time to jump. Use the Option menu and select a time for One Button Marking. This is the amount of time the system jumps back to create the In Point after an Out Point is set. Four seconds is the default.

Wait to see an event you want pass by on the live shot, then count to three and press the OUT button. Notice in the CLIP LIST there is a 4 second event. It’s In Point is 1 second back from the start of the action because you counted to three before pressing the OUT button.

A 4 second clip has been created by only pressing the OUT button using this one button marking technique.

b) Out Point Padding

Setting an Out Point Padding time can increase the length of time a clip in the CLIP LIST plays while leaving the duration of the event unchanged. Out Point Padding can be set to Infinite and the clip will play forever.

Keep in mind that the duration of the clip is not changed by setting Out Point Padding. A clip in the CLIP LIST can play forever, regardless of the duration or Out Point, but if the clip is added to the PLAY LIST for later use, it only plays for the length of its duration.

<table>
<thead>
<tr>
<th>Event ID</th>
<th>In Point</th>
<th>Out Point</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-10</td>
<td>14.32.00.07</td>
<td>14.32.10.07</td>
<td>00.00.10.00</td>
</tr>
<tr>
<td>0-11</td>
<td>14.31.26.01</td>
<td>14.31.26.02</td>
<td>00.00.00.01</td>
</tr>
<tr>
<td>0-13</td>
<td>16.10.04.28</td>
<td>16.10.04.29</td>
<td>00.00.00.01</td>
</tr>
<tr>
<td>0-14</td>
<td>16.10.04.28</td>
<td>16.10.07.18</td>
<td>00.00.02.20</td>
</tr>
<tr>
<td>0-15</td>
<td>16.10.26.08</td>
<td>16.10.34.24</td>
<td>00.00.12.16</td>
</tr>
</tbody>
</table>
The actual Out Point of a clip is easily changed either by dragging on the time code with the mouse or by selecting the clip, jogging past the original Out Point, and pressing \textit{SHIFT + OUT}. This changes the Out Point for all clips in this event.

When you jog to the end of the clip, it stops. To go beyond the Out Point, hold the \textit{SHIFT} button and continue jogging. Once the proper Out Point is seen, hold \textit{SHIFT} and press the \textit{OUT} button to change it.

You could also add clips to the \textit{PLAY LIST} as is and change the Out Point in the \textit{PLAY LIST}.

c) \textbf{Mark In with No Out} (3:10)

You can also mark an In Point with no Out Point. This allows an event to playback with no Out Point to stop it. It also allows the replay to be ready and cued before the action is finished.

To mark an in with no Out Point, make sure you are recording and in \textit{LIVE} mode. When the action starts, press the \textit{IN} button. This creates an event with no Out Point. Now, go to \textit{CLIP LIST} mode, choose an angle for playback, then initiate playback by pressing the \textit{Play} button. This clip has no Out Point, so it continues to play until you stop it.

Once you are finished with playback, press the \textit{OUT} button to finalize the clip and prepare for the next one. The \textit{IN} button remains blue until the event is completed with an Out Point.

d) \textbf{Delayed Playback Mode} (4:00)

There is another method for creating instant replay called “delayed playback mode”. This mode does not create a clip at all, but allows you to instantly playback anything that has already happened.

To use delayed playback mode, make sure you are recording and in \textit{LIVE} mode.

At anytime, turn the jog shuttle wheel approximately a quarter turn to the left, and the action stops. Then, jog to the desired In Point. Press \textit{Play} to start playback or ramp the \textit{T-bar}. There is no event, so play until the action of interest is over.

When finished, you can press the \textit{OUT} button to create an event, but you will probably have to edit the In Point so that the event includes the start of the action.

e) \textbf{Bookmarking} (4:50)

Bookmarks create placeholders in the time code that can be jumped to later. You must be recording to set a bookmark. Every time the \textit{BOOK MARK} button is pressed, it places a bookmark at that time code.
Up to 10 bookmarks can be created. If you set more than 10, the 11th bookmark replaces the first one and so on with the oldest bookmark being dropped in favor of the newest.

To go back to created bookmarks, hold SHIFT and press the BOOK MARK button repeatedly to jump through all bookmarks sequentially.

Notes: _______________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________
10: Working with the CLIP LIST

![CLIP LIST interface](image)

a) Choosing Playback Angle (0:05)

When you go to the **CLIP LIST** after creating an event, the camera angle viewed during event creation is pre-selected for playback. You can always change the camera angle. If you leave CLIP LIST mode, then return to it without creating a new event, the last selected clip is still selected.

While a clip is playing back, you can jump between camera angles. Hold down the **ANGLE** button on the Control Surface and use the number pad to choose an angle interactively. Alternatively, you can use the arrows keys to go to the next or previous angle. You can also click on an angle with the mouse during playback.

b) Clip Angle Previews (0:45)

The 3Play 4800’s clip angle previews enable you to know what input you are jumping to when switching camera angles. You can see these either on the main user interface or on the secondary Multiviewer.

To see clip angle previews on the main user interface, go to the **Options** menu and select **Show CLIP LIST Angle Previews**. This creates a row of monitors beneath the main user interface Multiviewer, and you can see all the camera angles playing back as the clip plays on output.

To see clip angle previews on the secondary Multiviewer, go to the **Output Configuration** panel by double clicking on an output monitor. Go to the **Aux Multiview** tab, and from the **Multiview Layout** pull-down select the option with **CLIP LIST Playback**. This puts all the angles on the secondary Multiviewer.
c) Unavailable Assets

If a CLIP LIST asset is not available, the clip is shown with a red outline around it. This can occur when a video input is not connected and an event is created or if a drive with that content is removed after an event was created.

d) Frame by Frame Viewing

You can use the Jog wheel for frame by frame analysis from different angles.

1. Cue a clip to the part of the action to be reviewed.
2. Roll back and forth over the area using the jog wheel.
3. Use the SHIFT button with the numeric keypad buttons on the Control Surface to change angles while scrubbing the clip. Or use the arrow keys to go to the previous or next clips while scrubbing.

Notes: ________________________________________________________________
                                                      __________________________________________
                                                      __________________________________________
                                                      __________________________________________
                                                      __________________________________________
                                                      __________________________________________
                                                      __________________________________________
11: Tagging Clips

Tagging a clip is a way of adding information to the clip that can be searched for easy cue-up and playback. Instead of having to type words, the tagging workflow allows pre-defined tags to quickly be applied to clips with just a few keystrokes on the Control Surface. This allows you to use your own terminology within any event.

a) **TAGS Area Overview** (0:30)

To toggle the **TAGS** area, click on the word **TAGS** in the title bar on the interface or press **SHIFT + TAG** on the Control Surface. By clicking the mouse on either side of the title bar, you can scale the **TAGS** area. Once scaled, this is the size that will reveal when toggled.

Along the top is the tab and options area and below that are the cells. The tabs can be renamed by right-clicking and selecting **Rename**. There are three tabs by default, but using the + button, you can add as many as you like.

b) **Editing Tags and Tabs** (1:20)

Each tab has 99 cells that can be used as tags in that category.

To editing existing cells, click the **Edit Tags** button and all the cells in the selected tab highlight, indicating they are able to be edited. Click on a cell and type the information you want in that cell. To advance to the next cell, either click on the next cell or press **ENTER** on the Control Surface or keyboard.
To advance to the next tab, either click on it or hold down \textit{SHIFT} and press the \textit{Next Tab} button (has the word \textit{TAB} with a right-pointing triangle on it) on the Control Surface.

You can create as many tabs as you want with the $+$ button. When finished editing the tags, exit the edit mode by clicking the \textit{Edit Tags} button again and the cells lose their highlight.

c) Applying Tags to Events (3:25)

Once the tags have been defined, you can apply this information to a clip or event.

To manually enter tags to clips:

1. Press the \textit{CLIP LIST} button
2. Select the clip using the navigation buttons
3. Type whatever information you want on the alpha-numeric keyboard, and it is added to the selected clip’s dataview port
4. Press \textit{ENTER} to add that information to the clip itself

To manually tag clips with the mouse:

1. Press the \textit{CLIP LIST} button
2. Select the clip using the navigation buttons
3. Press \textit{SHIFT} $+$ \textit{TAG} to reveal the \textit{TAGS} area
4. Click on a tag, and it is added to the selected clip’s dataview port
5. If desired, click on other tags in this or other tabs
6. Press \textit{ENTER} to add the info to the clip

To manually tag clips with the Control Surface:

1. Press the \textit{CLIP LIST} button
2. Select the clip using the navigation buttons
3. Press \textit{SHIFT} $+$ \textit{TAG} to reveal the \textit{TAGS} area
4. Press the \textit{TAG} button on the Control Surface to highlight it
5. Press the number of the column if working in tabs with only one row of tags
6. If working in a tab with more than one row, first press the row number button on the Control Surface number pad, then the column number
7. Press \textit{ENTER} to add the info to the clip

If a tab has more than one row, there is a visual cue about selecting the cell. The rows highlight first, saying “use me first and that is all you can do.” Once a row is chosen, the columns highlight, saying “use me next and when you do the cell info is
added.” So, for a tab with more than one row of cell data, type the row number first, then the column. Use a 0 to select a cell in the first row.

You can advance back and forth through the tabs using the Control Surface by pressing the SHIFT key and using the TAB buttons by the navigation controls to go forward and back.

Once finished tagging, press the ENTER button to add the tags to the clip, then press the TAG button to exit the Tag mode. The TAG button is not lit when it is not active.

Press SHIFT + TAG to toggle the TAGS area.

d) Auto Advance

Auto Advance allows you to apply multiple tags from multiple tabs easily. With this button turned on, every time a tag from a tab is added, tag selection advances to the next tab.

For instance:

1. Go to the CLIP LIST and select a clip with the navigation buttons.
2. Press the TAG button to enter the Tag mode. The TAG button lights up.
3. Reveal the TAGS area if you can’t see it using the SHIFT + TAG button on the Control Surface.
4. Enter the cell number for the visible tab and tag the clip.
5. Notice the tab advanced to the next one.
6. Now enter a tag from that tab and it advances again.
7. Once done adding tags, press ENTER to complete. This can be done after entering only one tag if that is all that you want to add.

This is an excellent way to add a lot of information to a clip quickly.

e) Searching for Tag Information

Any information added to the FastClip dataview port can be searched. Type the keyword into the FastClip dataview port and press SEARCH. The search will show any event that has a clip with that information in it so there is no need to tag every angle, unless it is a special angle. These search results are shown in their own tab.

When commenting on clips use a structure. Call all goals “goal,” not one “goal” and one “score”.

Player numbers are a great way to seek out an instant highlight reel for a specific player.

Once data is created, use the SEARCH button to do a key word search to find all events that contain that data.
The Search Results tab shows anything that has been searched.

f) The Event ID

Once events are created, they are given an Event ID. The Event ID is made up of two numbers: the first is the clip bin number; the second is event number within the bin.

You can cut, copy and paste events into any bin using those commands from the Control Surface. Notice that clips in bins all start with that bin number, but clips in a search result could be from several bins.

g) Using GO TO

The GO TO button takes you to the event directly in its original bin, as opposed to showing the search results. For instance, you can search for a term, select a clip from the search results, press GO TO, and you are taken to that clip in its original bin.

GO TO allows you to instantly jump to any tab and any clip, if you know the tab number and clip ID. Type the Event ID and press GO TO.

The GO TO button can also be used to jump to a specific timecode. Type a time code into the dataview port, then hold down SHIFT and press GO TO. This jumps the selected output to this time code, but does not create an event. You can start playing from here or create an event using any of the methods described.

Notes:

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
12: Adding Media

a) The Add Media Button (0:05)

In the CLIP LIST area there is an Add Media button. This button loads media that was imported using the Media Importer into the CLIP LIST. This can be video clips, audio clips, or stills you want to incorporate into the replay production. Click Add Media and select a video clip you imported. Notice when the clip loads, all camera angles are labeled with the clip name and all angles play the same thing.

b) Media Browser (0:40)

You can also use the controls in the Media Browser to navigate to external content that was not imported into the session. There is a Browse button which allows you to look on any drives attached to the system.
c) Add Media Location (0:50)

If you frequently want to have access in the Media Browser to a folder of content, you can add it as a new media location. Click on Add Media Location and navigate to the folder; it now appears in the browser like other content that was imported.

d) Other Import Notes (1:05)

Media should be played back from a media drive. Don’t add a USB drive as a media location and try to play video from it since it will be too slow. Also, adding clips from external sources, even if copied to a media drive, may not play back if the codec is not supported. To be sure everything will play, use the Media Importer.

Notes: ____________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________
13: Playback Speed Control

a) Playback Controls
   (0:05)
   Any selected clip can be reset to its In Point by pressing the Stop button twice.

   To start the clip playing, press the Play button. This plays the clip at 100% speed, no matter where the T-bar is. Using the T-bar will ramp the speed dynamically.

   With the clip reset to the In Point, move the T-bar to 0. Then, as you bring it up, the clip speed ramps up over time. Notice the color on the T-bar fades out at 0 and is brightest at 100%.

b) The +/- Button
   (0:55)
   The +/- button on the Control Surface changes the behavior of the T-bar. Push it to turn the function on. Now, when the T-bar is at the halfway point, this is 0% speed or pause. Notice the T-bar color is faded out. Pushing the T-bar forward speeds the clip up to a maximum of 200% and pulling the T-bar down runs the clip in reverse up to 200% speed. This allows you to rock the T-bar back and forth to review a play. Camera angles can be changed while doing this.

Notes: ________________________________________________________________

________________________________________________________

________________________________________________________
There are several workflows available when using the *CLIP LIST* to playback clips.

a) **Playout from One Output** (0:15)

Playout from one output is the way most replay operators start to learn the flow of a production. To do this, simply select a clip in an event, then pull the T-bar down to 0% and ramp it up to start playback. The T-bar is now controlling playback speed.

b) **Jumping to Different Angles** (0:40)

Jumping to different angles is also possible. To see the angles of an event play back one after another, hold down *SHIFT* and *ANGLE* at the same time, then choose a new angle from the number pad. The 3Play then outputs the newly selected angle from the beginning of the event.
15: Dual Outputs

a) Dual Output

Having two independent outputs can be very useful. One output can be used for instant replay and slow motion, and the other used to feed in-arena digital signage or large displays. Both outputs can also be used together to create a customized view of the action as a replay.

b) Linking Both Outputs Together

Two different clips can be controlled at the same time using the T-bar by linking them together. This is especially useful for feeding the switcher two different angles of the same play so the operator can switch between them.

To link two clips together, select a clip for playback on Output A, and another angle of the same play on Output B. Press the LINK button, then pull the T-bar to 0%. Now, ramp the T-bar up or press the Play button and both outputs play the two different angles at the same speed, controlled by the T-bar.

The LINK button only links the playback controls of both outputs. If the LINK button is active with Channel A selected, then a clip selected in the CLIP LIST only cues in Channel A. Channel B is only affected when the transport or speed controls are used.

Linked transport controls can also delay live video. If both outputs are live and the LINK button is on, then when the wheel is turned a quarter turn, both outputs go into delayed playback mode.

c) Preview to Program Workflow

Both outputs can be used together to send the result out of the B output. This is a preview to program style workflow allowing for cuts and transitions between playback angles. When working in this mode, the B output is the most important. It
shows the transition from B to A and it is output Row 2 on the back of the system. If using transitions with audio, the audio comes out of audio output Row 2.

d) **Autoplay**

(2:20)

You most likely want to turn on the *AutoPlay* option when using a preview to program style workflow. This causes the clip on Output A to start playing when as it is transitioned to Output B. To turn *AutoPlay* on, open the small arrow next to the transition speed control and set the check mark by *AutoPlay*.

e) **Using the TAKE Button**

(2:40)

You can perform a cut between two clips using the *TAKE* button.

Select a clip for playback on Output B, making a note of the *Event ID*. Pull the *T-bar* to 0% and ramp it up. Select Output A and choose a different angle of the same *Event ID*. Jog to a new In Point. When the action finishes on the first angle (on Output B), press the *TAKE* button. The clip on Channel A cuts to Output B and the new angle begins to play from the cued point.

f) **Setting up a Transition**

(3:25)

The transition area is under the Output B Heads Up Display (HUD). Clicking the *Transition* icon opens the *Transition Palette*. This palette displays nine transitions to choose from.

*Fade* cannot be replaced, but all others can. Mouse over a transition, click the + in the upper right corner, and the *Media Browser* launches. Navigate to a transition and select it. The original transition is replaced by the selected one. You can use full-color motion graphic transitions with audio. These are called “Animation Store” transitions and a variety of them are included with the 3Play.

When one of the nine transitions is selected, its icon appears in the transition area. Transitions can be selected with the mouse using the palette or by holding *SHIFT* and using the number pad to select a transition number. The speed of the transition is set on the dropdown using the included presets. You can also click and drag to scrub to a new speed.

The audio level for Animation Store transitions is set using the fader from the speaker icon. This audio level is global for all transitions. The *TAKE* and *AUTO* buttons on the interface are also on the Control Surface. There are also *Stop* and *Play* buttons on the Control Surface. The *Loop* button loops the selected output. One output can be looped while the other is not. Looping controls are only on the interface.

g) **Using a Transition**

(5:25)

Select a clip for playback on Output B, making a note of the *Event ID*. Pull the *T-bar* to 0% and ramp it up. Select Output A and choose a different angle of the
same Event ID. Jog to a new In Point. When the action finishes on the first angle (on Output B), press the AUTO button. The clip on Channel A transitions to Output B and the new angle begins to play from the cued point.

Once the transition is complete, you can go back to Output A, select another angle, cue it, and AUTO to it.

Transitions give visual interest to a production, but using them between each angle is sometimes too much. Try using a transition to go into the replay, then fades between angles, and a transition to go out of the replay.

h) Speed Control Using 2 Outputs

When it comes to transitions, the speed of one output does not affect the speed of the other output. If Output B is playing at 50% and Output A playing at 100%, then when the clip in A is transitioned to B, it keeps playing at 100%. The speed of playback follows the clip, not the output.

Notes: __________________________________________________________

_______________________________________________________________

_______________________________________________________________

_______________________________________________________________

_______________________________________________________________

_______________________________________________________________

_______________________________________________________________

_______________________________________________________________
a) **PLAY LIST** Tabs

As the game progresses some events are highlights of the game. Make sure to comment on these or tag them to easily locate them later.

These clips can also be dropped into the **PLAY LIST** as they occur. The **PLAY LIST** has 10 tabs, but you can add as many as you like. These tabs help organize the **PLAY LISTS** as you create them.

b) Adding Clips to the **PLAY LIST**

When in CLIP LIST mode, pressing *Add to PLAY LIST* drops that camera angle of the event into the **PLAY LIST**. You can also drag angles from the **CLIP LIST** to the **PLAY LIST**. You can multiple-select using the *SHIFT* key on the Control Surface.

If you drag the Event ID down, or select the Event ID and press *Add to PLAY LIST*, all camera angles associated with that event are copies to the **PLAY LIST**. It may be easier to eliminate the two angles you don’t want as opposed to adding the four you do.

c) Adjusting Clips in the **PLAY LIST**

The clips in the **PLAY LIST** can be dragged into any order, or you can use the Control Surface to cut and paste the clips into the desired order.

You can adjust In and Out Points of any clip in the **PLAY LIST** in the same way as the **CLIP LIST**. **PLAY LIST** adjustments have no effect on the event in the **CLIP LIST**.
d) **PLAY LIST Transitions**  
(1:25)  
You can choose to have a transition happen in-between two clips during playback by selecting a transition from the palette. Transitions can be added to this palette the same way they are added to the other transition area or set it for a cut between clips. The transition rate can be controlled with the dropdown.  

You can adjust the playback speed of a clip in the **PLAY LIST**. But if you do this and then use the **T-bar**, it is a cumulative effect. If you set the speed in the **PLAY LIST** to 50% and then drag the **T-bar** to 50% the clip plays at 25%.

---

e) **The Ends At Time**  
(2:15)  
The *Ends At* time is a cumulative time showing the total time of the **PLAY LIST** to playback. This time readout is only if the list is played at 100% speed with the **T-bar**.

---

f) **Adding Music to the **PLAY LIST****  
(3:15)  
To add a music bed, click on the **Music** button at the upper right corner of the **PLAY LIST**. Select **Browse** on the popup menu and choose the desired music clip. These audio clips should be imported before the start of the live production. Click on the gear next to the popup for music variables. **Starts At** allows you to create an offset to the start time of the music. There is also a volume control.

---

g) **Playing the **PLAY LIST****  
(3:50)  
Select **PLAY LIST** on the Control Surface and press **Play**. The clips start playing. If you wish to push to the next clip, press the **Next Clip** button on the transport controls. This advances to the next clip using the transition.

A **PLAY LIST** can be started from any point by selecting a clip in the list and initiating playback. The **PLAY LIST** plays from the selected clip to the end of the list.

To cue the **PLAY LIST** to the top, press **Stop** three times. Pressing **Stop** the first time stops playback. Pressing **Stop** the second time resets that clip to its start point. Pressing **Stop** the third time resets the entire **PLAY LIST** back to the beginning.

---

h) **Adding Media to a PLAY LIST**  
(4:35)  
The **PLAY LIST** has an **Add Media** button. This loads clips and media to the **PLAY LIST** which were imported or added to the media drives before the production. This is useful for adding a sponsorship bumper to the beginning of a replay.
i) External Editors (5:00)

Another way to add edit capabilities to a workflow is to add a non-linear editor. Media folders can be shared on the network. This gives editors external to the production access to the media drives. In this case, we can add edited clips or video packages to those drives during a production. Make sure they are a file format that will play correctly.

j) Exporting PLAY LISTS (5:30)

Once you have created PLAY LISTS, you can export them for use outside of the 3Play. You can render any PLAY LIST back to the CLIP LIST as a single clip. This makes it available for export using the Media Exporter. To render a PLAY LIST to the CLIP LIST, press the Export to CLIP LIST button in the upper left corner of the PLAY LIST. The clip name created matches the name of the tab from which it is rendered. These rendered clips will now be available for use outside of the 3Play.
17: Social Media Publishing

a) Publishing (0:05)

A replay operator needs to be able to do three things: mark clips, cue clips, and play clips. Although the 3Play 4800 does not stream anything live, it has the ability to publish content from the system to social media sites like Facebook, Twitter and YouTube, or to send files to a network drive or FTP for use outside of the system.

Publishing clips to a local drive is another way to quickly get content from one place to another. The destination can be an external eSATA drive which can be disconnected and taken to an edit bay after content is exported to it. Stills and video clips of the event can be exported while the event is still being recorded. Recording does not have to be stopped to have access to content from the event.

b) Publish Destinations (1:00)

All publishing destinations need to be configured in pre-production on the Home or Session page. These configurations are global and apply to all events until you change them. Configuring the destinations is covered in the Home and Session page sections of this training series.

A Publish Queue and Publish Destination are found in the File menu. Publish destinations are set up separately for publishing video and stills. The main difference is stills can’t go to YouTube and video can’t go to Twitter. Once configured, put a check mark by the destinations you want to publish to.

c) Auto Upload (1:45)

Auto Upload is an option that automatically starts uploading media as soon as it is sent to the Publish Queue. This is the quickest way to get content from a game or event on the web.

d) Adding Media to the Publish Queue (2:10)

The Publish Queue shows all the media that is currently set to upload. Media can be added to the queue several ways.
Clicking the *Add* button gives access to all imported media and any *PLAY LISTS* that were exported. You can add them, comment on them, and choose a destination. Then click *Upload* to publish them. You can also duplicate a clip and set it to upload to multiple destinations.

Adding a clip from the *CLIP LIST* loads the entire clip into the *Publish Queue* for publishing. Select a clip with the Control Surface and press the *PUBLISH* button. The clip now appears in the *Publish Queue*. If you want to edit the clip’s In and Out Points before uploading, do this in the *PLAY LIST* since that does not affect the In and Out Points in the *CLIP LIST*.

Once you’ve set the correct In and Out Points, press *PUBLISH* to send it to the *Publish Queue*. Once in the queue, you can change the name of the clip and add comments. The duration is for display only and cannot be edited. Media can also be deleted from the *PLAY LIST* if you don’t need it.

### e) Adding Stills

The *GRAB* button is for grabbing still images for use in the production or for publishing. When images are grabbed, a still is taken from both outputs and all inputs.

The *Grab Panel* is assessed by using the gear next to the *Grab* button. In the panel, stills are given a base name. De-interlacing images removes jitter if they were captured from an interlaced session, like 1080i or 480i. This is not needed if the session is progressive, such as 720p.

If *Add to Publish Queue* is selected, one image is sent to the *Publish Queue* when an image is grabbed. That is whatever image is on the currently selected output. This image is in the queue and ready for upload. However, all images have been captured. To get to the other images, press the *Add* button and look under *Stills* for the session name. An image is there from each output and one from each camera input. Any image can be added to the *Publish Queue* from here.

### f) Publishing Locally

To have more control over what goes up on social media sites, you can publish content to a local drive where a media tech can prepare it, tag it, add links, etc. before uploading traditionally.

The quickest way to get video or stills on the web or on an FTP or local drive is to set the destinations to *Auto Upload*. Then, put media in the *Publish Queue* in one of the ways discussed.

Notes: __________________________________________________________

_________________________________________________________________

_________________________________________________________________
18: Exporting Media

a) Exiting the Session (0:05)

Once the production is finished, render any PLAY LISTS you want to use outside of the 3Play to the CLIP LIST. Now, exit the live production mode by using the File menu and selecting Exit. You are asked if you are sure you want to exit, click Exit. This takes you to the Session page.

From the Session page, you have access to the content created in the session. Clicking the Clips button shows all rendered PLAY LISTS exported to the CLIP LIST. Stills shows the capture folder holding all stills created with the GRAB button during the session. Sound and Music shows all the imported music in the session.

b) The Export Media Panel (0:45)

The Export Media panel enables you to select any angle from any event to export in a variety of file formats. You also have access to any PLAY LISTS that have been rendered to the CLIP LIST.

Press the Add button, then select individual camera angles to export. You can CTRL-click to select multiple angles. Selecting an Event ID sends all camera angles of that event to the export panel. Clips cannot be previewed from here, so look at the clips and events in the live desktop and take notes as to what you want to export.

Once items are selected press OK. This loads the clips into the Export Queue. Each clip can be set up individually or you can multi-select items by SHIFT or CTRL-clicking and adjust them as a group.
Once items have been added to the Export Queue, select a target. This is a use-type for the clip to be exported.

Next, select a preset for that target. For instance, a target of Application shows non-linear editors you might want to use to edit the video. Changing the target to Video Servers shows presets for video server types.

Next, configure the Export Destination. This can be any drive available on the system. Use the drop down menu and select Browse.

Clips can be duplicated for export to multiple formats at once.

Clip handles can be applied to add a few seconds to the beginning and end of a clip on export to facilitate editing.

Once all the clips are configured, press the Export button.

To transport the 3Play session to another machine, all the drives are needed. There is no way to back up a session on a 3Play 4800.

c) Edit Decision List (EDL) (2:50)

Upon exiting the 3Play session, an edit decision list (EDL) is created for use in external editor’s. This EDL is found on the session drive under Media/EDL/Session name.

Notes: ________________________________________________________________

_______________________________________________________________________

_______________________________________________________________________

_______________________________________________________________________

_______________________________________________________________________

_______________________________________________________________________

_______________________________________________________________________
Appendix A: Selected Keyboard Shortcuts

The complete set of keyboard shortcuts is found in Appendix C of the 3Play User Guide.

Previous row  Up arrow
Next row  Down arrow
Previous cell  Left arrow
Next cell  Right arrow

First cell in row  Home
Last cell in row  End
First cell in table  CTRL + Home
Last cell in table  CTRL + End

Cut  CTRL + x
Copy  CTRL + c
Paste  CTRL + v
Remove event/item  Delete Key
Confirm edit  ENTER
Copy Memo text to all angles of an event  SHIFT + ENTER
Exit text edit without saving changes  Esc

Mark In  Alt + i
Mark Out  Alt + o
bookmark (set)  CTRL + b
Bookmark (jump to previous)  CTRL + SHIFT + b

Delegate Channel A (Control)  CTRL + [  
Delegate Channel B (Control)  CTRL + ]  
Link Channels (toggle)  CTRL + = 
Source Delegate – LIVE  CTRL + l (lower case L) 
Select input or angle  Alt + Numpad (1-8) 
Previous input or angle  Alt + (left arrow) 
Next input or angle  Alt + (right arrow)
### Appendix B: Acronyms Used in the Training Curriculum

(note: file format abbreviations, such as PDF, JPG, WAV, etc., are not listed)

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC/DC</td>
<td>Alternating Current/Direct Current</td>
</tr>
<tr>
<td>AES/EBU</td>
<td>Audio Engineering Society/European Broadcasting Union</td>
</tr>
<tr>
<td>BKGD</td>
<td>Background</td>
</tr>
<tr>
<td>BNC</td>
<td>Bayonet Neill-Concelman</td>
</tr>
<tr>
<td>CDN</td>
<td>Content Delivery Network</td>
</tr>
<tr>
<td>CS</td>
<td>Control Surface</td>
</tr>
<tr>
<td>DDR</td>
<td>Digital Disk Recorder</td>
</tr>
<tr>
<td>DSK</td>
<td>Down Stream Key</td>
</tr>
<tr>
<td>DV</td>
<td>Digital Video</td>
</tr>
<tr>
<td>DVD</td>
<td>Digital Video Disc</td>
</tr>
<tr>
<td>DVI</td>
<td>Digital Visual Interface</td>
</tr>
<tr>
<td>FAQ</td>
<td>Frequently Asked Questions</td>
</tr>
<tr>
<td>FAT32</td>
<td>File Allocation Table (32-bit)</td>
</tr>
<tr>
<td>FTB</td>
<td>Fade To Black</td>
</tr>
<tr>
<td>FX</td>
<td>Effects</td>
</tr>
<tr>
<td>HD/SD</td>
<td>High Definition/Standard Definition</td>
</tr>
<tr>
<td>HDMI</td>
<td>High Definition Multimedia Interface</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>IMAG</td>
<td>Image Magnification (projector)</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>IRE</td>
<td>Institute of Radio Engineers</td>
</tr>
<tr>
<td>iVGA</td>
<td>Internet Video Graphics Array</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>LC-11</td>
<td>Live Control (Control Surface)</td>
</tr>
<tr>
<td>Mbps</td>
<td>Megabits Per Second</td>
</tr>
<tr>
<td>NTSC</td>
<td>National Television Standards Committee</td>
</tr>
<tr>
<td>NTFS</td>
<td>New Technology File System</td>
</tr>
<tr>
<td>PAL</td>
<td>Phase Alternating Line</td>
</tr>
<tr>
<td>QR Code</td>
<td>Quick Response Code</td>
</tr>
<tr>
<td>RCA</td>
<td>Radio Corporation of America</td>
</tr>
<tr>
<td>RGB</td>
<td>Red, Green, Blue</td>
</tr>
<tr>
<td>SDI</td>
<td>Serial Digital Interface</td>
</tr>
<tr>
<td>S/PDF</td>
<td>Sony/Philips Digital Interconnect Format</td>
</tr>
<tr>
<td>UPS</td>
<td>Universal Power Source</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>VGA (XGA, SXGA, WXGA)</td>
<td>Variants of the Video Graphics Array standard</td>
</tr>
<tr>
<td>VPN</td>
<td>Virtual Private Network</td>
</tr>
<tr>
<td>VU</td>
<td>Volume Unit</td>
</tr>
<tr>
<td>Y/C</td>
<td>Another name for the S-video standard</td>
</tr>
<tr>
<td>YUV</td>
<td>Another name for the YCbCr color space</td>
</tr>
</tbody>
</table>